IBM Data Studio Full Client
Version 3.1.1

Configuring DB2 For z/OS Subsystems
for the No-Charge Tuning Features

IBM
Configuring DB2 For z/OS Subsystems for the No-Charge Tuning Features
Contents

Configuring DB2 for z/OS subsystems for use with the no-charge tuning features in IBM Data Studio 1
Running JCL to configure DB2 for z/OS subsystems for use with the no-charge tuning features 1
Using the IBM Data Studio full client to configure DB2 for z/OS subsystems for use with the no-charge tuning features 3
Authorities and privileges for configuring DB2 for z/OS subsystems from IBM Data Studio 4
Creating connections to DB2 for z/OS subsystems that you are using for query tuning 5
Packages to bind on DB2 for z/OS subsystems for the no-charge tuning features 8
Sharing EXPLAIN tables 9
Required EXPLAIN tables 10

Optional tasks for configuring DB2 for z/OS subsystems for tuning 13
Enabling the SYSPROC.OPT_RUNSQL stored procedure on a DB2 for z/OS subsystem 13
Configuring database groups 13

Notices 15
Trademarks 17

Index 19
Configuring DB2 for z/OS subsystems for use with the no-charge tuning features in IBM Data Studio

After you install the IBM® Data Studio full client, Version 3.1.1 on your workstation, you can configure your DB2® for z/OS® subsystems for tuning SQL statements.

Configuring for tuning includes creating EXPLAIN tables and other tables, table spaces, indexes, and aliases. It also includes binding required packages. You can carry out this task either by running JCL on your subsystem, or by connecting to the subsystem with the IBM Data Studio full client and using a configuration wizard.

Running JCL to configure DB2 for z/OS subsystems for use with the no-charge tuning features

You can configure DB2 for z/OS subsystems for use with the no-charge tuning features by submitting a JCL job.

Before you begin

Ensure that the IBM Data Studio full client, Version 3.1.1 is installed on a workstation that you have access to.

About this task

If your subsystem was configured for the no-charge tuning features that were in IBM Data Studio full client or administration client, Version 3.1, then you do not need to follow the steps in this procedure.

Procedure

Perform the following steps on the DB2 for z/OS subsystem to configure it for tuning SQL statements:

1. Upload the required JCL job files and DBRMs to the subsystem from the client system.

   The JCL files and DBRMs are located inside the installation directory for the IBM Data Studio full client.

   • If you installed the IBM Data Studio full client on a Windows system, the JCL is in the installation_directory\QueryTunerServerConfig\no_charge_features\ZOS\version_number_and_mode directory.

   • If you installed the IBM Data Studio full client on a Linux system, the JCL is in the .installation_directory/QueryTunerServerConfig/no_charge_features/ZOS/version_number_and_mode directory.

   Upload the JCL files in ASCII format and the DBRMs in binary format.
<table>
<thead>
<tr>
<th>Name of subfolder</th>
<th>V9</th>
<th>V10CM8</th>
<th>V10CM9</th>
<th>V10</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of files</td>
<td>JCL: AOCDDL9</td>
<td>JCL: AOCDDLX8</td>
<td>JCL: AOCDDLX9</td>
<td>JCL: AOCDDL10</td>
</tr>
<tr>
<td></td>
<td>DBRMS: AOC5OADM</td>
<td>DBRMS: AOC5OADM</td>
<td>DBRMS: AOC5OADM</td>
<td>DBRMS: AOC5OADM</td>
</tr>
<tr>
<td></td>
<td>AOC5OEPK</td>
<td>AOC5OEPK</td>
<td>AOC5OEPK</td>
<td>AOC5OEPK</td>
</tr>
<tr>
<td></td>
<td>AOC5OEXK</td>
<td>AOC5OEXJ</td>
<td>AOC5OEXK</td>
<td>AOC5OEXM</td>
</tr>
<tr>
<td></td>
<td>AOC5OFMJ</td>
<td>AOC5OFMM</td>
<td>AOC5OFMM</td>
<td>AOC5OFMM</td>
</tr>
<tr>
<td></td>
<td>AOC5ONPT</td>
<td>AOC5ONPT</td>
<td>AOC5ONPT</td>
<td>AOC5ONPT</td>
</tr>
<tr>
<td></td>
<td>AOC5OPKG</td>
<td>AOC5OPKG</td>
<td>AOC5OPKG</td>
<td>AOC5OPKG</td>
</tr>
<tr>
<td></td>
<td>AOC5OSA</td>
<td>AOC5OSA</td>
<td>AOC5OSA</td>
<td>AOC5OSA</td>
</tr>
</tbody>
</table>

2. If your subsystem was configured for earlier versions of IBM Data Studio, and before configuring for version 3.1.1 you want to drop both the data objects from those earlier versions and the data in those objects, drop the following databases.

**Important:** This step is not required. Follow it only if you are sure that you want to delete the data that is in these databases.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If your subsystem is configured for versions 2.2.1 or 2.2.1.1:</td>
<td>Drop databases DB2OSC, DSNOSCDB, and AOCOEDB.</td>
</tr>
<tr>
<td>If your subsystem is configured for versions that are earlier than 2.2.1:</td>
<td>Drop databases DB2OSC, DSNOSCDB, and DB2OE.</td>
</tr>
</tbody>
</table>

3. If your subsystem was configured for IBM Optimization Service Center, and before configuring for version 3.1.1 you want to drop both the data objects from those earlier versions and the data in those objects, drop databases DB2OSC and DSNOSCDB.

**Important:** This step is not required. Follow it only if you are sure that you want to delete the data that is in these databases.

4. Create the tables for Version 3.1.1. On the subsystem, modify the corresponding AOCDDL JCL job file to conform to your environment, then submit the job. The following table lists the AOCDDL JCL job files for each environment.

<table>
<thead>
<tr>
<th>DB2 subsystem</th>
<th>JCL job to create the query tuning tables for Version 3.1.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 Version 10 for z/OS new-function mode</td>
<td>AOCDDL10</td>
</tr>
<tr>
<td>DB2 Version 10 for z/OS conversion mode from Version 9</td>
<td>AOCDDLX9</td>
</tr>
<tr>
<td>DB2 Version 10 for z/OS conversion mode from Version 8</td>
<td>AOCDDLX8</td>
</tr>
<tr>
<td>DB2 Version 9 for z/OS</td>
<td>AOCDDL9</td>
</tr>
</tbody>
</table>
Using the IBM Data Studio full client to configure DB2 for z/OS subsystems for use with the no-charge tuning features

You can connect to a DB2 for z/OS subsystem from the IBM Data Studio client and configure the subsystem by using a wizard.

Before you begin

- You must have the authorities and privileges that are required for configuring a DB2 for z/OS subsystem for query tuning.
- Ensure that the client is connected to the subsystem.
- Ensure that the subsystem is configured to connect to other systems with TCP/IP.


Procedure

To configure a DB2 for z/OS subsystem for query tuning with the no-charge features:

1. If you want to drop data objects that were created for earlier versions of IBM Data Studio and you want to delete the data that is in those objects, drop the following databases.

   **Important:** This step is not required. Follow it only if you are sure that you want to delete the data that is in these databases.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If your subsystem is configured for versions 2.2.1 or 2.2.1.1:</td>
<td>DB2OSC</td>
</tr>
<tr>
<td></td>
<td>DSNOSCDB</td>
</tr>
<tr>
<td></td>
<td>AOCOEDB</td>
</tr>
<tr>
<td>If your subsystem is configured for versions that are earlier than 2.2.1:</td>
<td>DB2OSC</td>
</tr>
<tr>
<td></td>
<td>DSNOSCDB</td>
</tr>
<tr>
<td></td>
<td>DB2OE</td>
</tr>
</tbody>
</table>

2. If your subsystem was configured for IBM Optimization Service Center, and before configuring for version 3.1.1 you want to drop both the data objects from those earlier versions and the data in those objects, drop databases DB2OSC and DSNOSCDB.

   **Important:** This step is not required. Follow it only if you are sure that you want to delete the data that is in these databases.

3. In the Data Source Explorer in the IBM Data Studio client, expand the connection to the subsystem. Right-click the icon for the subsystem for the
subsystem and select **Analyze and Tune > Configure for Tuning > Guided Configuration.** The configuration wizard opens.

4. Follow the instructions in the wizard.
5. Verify that the subsystem is configured for query or query-workload tuning. In the Data Source Explorer, right-click the subsystem that you configured, and then click **Analyze and Tune > Configure for Tuning > Advanced Configuration and Privilege Management.**
   
   You can check the status of the Query Tuner packages, Query Tuner tables, EXPLAIN tables, and the query tuning features in this window.

## Authorities and privileges for configuring DB2 for z/OS subsystems from IBM Data Studio

Ensure that you have the authorities and privileges that are required to configure a DB2 for z/OS subsystem from IBM Data Studio.

There are two sets of authorities and privileges that are required:

- **Authorities and privileges required to connect to and configure a DB2 for z/OS subsystem for tuning**
- **Authorities and privileges required to enable the EXPLAIN function on a DB2 for z/OS subsystem** on page 5

### Authorities and privileges required to connect to and configure a DB2 for z/OS subsystem for tuning

<table>
<thead>
<tr>
<th>Task</th>
<th>Authorities or privileges required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect to a DB2 for z/OS subsystem</td>
<td>All of the following authorities and privileges:</td>
</tr>
<tr>
<td></td>
<td>• Underlying DB2 access authority</td>
</tr>
<tr>
<td></td>
<td>• EXECUTE privilege on the following packages:</td>
</tr>
<tr>
<td></td>
<td>– AOC5OADM</td>
</tr>
<tr>
<td></td>
<td>– AOC5OEPJ (DB2 for z/OS Version 8)</td>
</tr>
<tr>
<td></td>
<td>– AOC5OEPK (DB2 for z/OS Versions 9 and 10)</td>
</tr>
<tr>
<td></td>
<td>– AOC5ONPT</td>
</tr>
<tr>
<td></td>
<td>– AOC5OPKG</td>
</tr>
</tbody>
</table>

**Bind packages**

<table>
<thead>
<tr>
<th>Task</th>
<th>Authorities or privileges required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bind packages</td>
<td>One of the following authorities and privileges:</td>
</tr>
<tr>
<td></td>
<td>• SYSADM or DBADM authority</td>
</tr>
<tr>
<td></td>
<td>• BINDADD privilege if required packages do not exist, and CREATEIN privilege on the schema</td>
</tr>
<tr>
<td></td>
<td>• ALTERIN privilege on the schema if the required packages exist</td>
</tr>
<tr>
<td></td>
<td>• BIND privilege on the required packages if they exist</td>
</tr>
</tbody>
</table>

**Free packages**

<table>
<thead>
<tr>
<th>Task</th>
<th>Authorities or privileges required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free packages</td>
<td>One of the following authorities and privileges:</td>
</tr>
<tr>
<td></td>
<td>• Ownership of the packages</td>
</tr>
<tr>
<td></td>
<td>• BINDAGENT privilege that is granted by the owner of the packages</td>
</tr>
<tr>
<td></td>
<td>• SYSCTRL authority</td>
</tr>
<tr>
<td></td>
<td>• SYSADM authority</td>
</tr>
<tr>
<td></td>
<td>• PACKADM authority for the collection or for all collections</td>
</tr>
<tr>
<td>Task</td>
<td>Authorities or privileges required</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Browse subsystem parameters</td>
<td>Both of the following authorities and privileges:</td>
</tr>
<tr>
<td></td>
<td>• EXECUTE privilege on the SYSPROC.DSNWZP stored procedure</td>
</tr>
<tr>
<td></td>
<td>• At least MONITOR1 system privilege</td>
</tr>
<tr>
<td>Manage users</td>
<td>One of the following privileges or authorities:</td>
</tr>
<tr>
<td></td>
<td>• The privilege WITH GRANT OPTION on required packages</td>
</tr>
<tr>
<td></td>
<td>• Ownership of the packages</td>
</tr>
<tr>
<td></td>
<td>• SYSADM authority</td>
</tr>
</tbody>
</table>

### Authorities and privileges required to enable the EXPLAIN function on a DB2 for z/OS subsystem

<table>
<thead>
<tr>
<th>Task</th>
<th>Authorities or privileges required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create EXPLAIN tables</td>
<td>If you want to create the EXPLAIN tables in a new database, one or more of the following privileges or authorities for creating the database:</td>
</tr>
<tr>
<td></td>
<td>• CREATEDBA privilege</td>
</tr>
<tr>
<td></td>
<td>• CREATEDBC privilege</td>
</tr>
<tr>
<td></td>
<td>• SYSADM or SYSCTRL authority</td>
</tr>
<tr>
<td></td>
<td>For creating the table space, one or more of the following privileges or authorities:</td>
</tr>
<tr>
<td></td>
<td>• CREATETS privilege for the database</td>
</tr>
<tr>
<td></td>
<td>• DBADM, DBCTRL, or DBMAINT authority for the database</td>
</tr>
<tr>
<td></td>
<td>• SYSADM or SYSCTRL authority</td>
</tr>
<tr>
<td></td>
<td>For creating the tables, one or more of the following privileges or authorities:</td>
</tr>
<tr>
<td></td>
<td>• CREATETAB privilege for the database</td>
</tr>
<tr>
<td></td>
<td>• DBADM, DBCTRL, or DBMAINT authority for the database</td>
</tr>
<tr>
<td></td>
<td>• SYSADM or SYSCTRL authority</td>
</tr>
<tr>
<td>Create aliases for existing EXPLAIN tables</td>
<td>One of the following privileges or authorities:</td>
</tr>
<tr>
<td></td>
<td>• The CREATEALIAS privilege</td>
</tr>
<tr>
<td></td>
<td>• SYSADM or SYSCTRL authority</td>
</tr>
<tr>
<td></td>
<td>• DBADM or DBCTRL authority on the database that contains the tables, if the alias is for tables and the value of field DBADM CREATE AUTH on installation panel DSNTIPP is YES</td>
</tr>
</tbody>
</table>

## Creating connections to DB2 for z/OS subsystems that you are using for query tuning

You can use the pages in the New Connection wizard to create a connection profile, so that you can connect to a DB2 for z/OS subsystem. This topic explains how to open the New Connection wizard from the Data Source Explorer view and the Administration Explorer view.
Before you begin

If you plan to connect to subsystems through DB2 Connect, ensure that the version of DB2 Connect is 9.5.7 or higher.

Procedure

To create a connection to a DB2 for z/OS subsystem:

1. Right-click in the Data Source Explorer, and select New from the pop-up menu.
   In the Administration Explorer, you can click New > New Connection to a Database from the Administration Explorer toolbar.

2. On the first page of the wizard, select DB2 for z/OS as the database manager, if you are connecting directly to the subsystem. If you are connecting through a gateway, select DB2 for Linux, UNIX, and Windows as the database manager. Then, specify other connection details, as described.

Connection identification

Specify preferences for naming the new connection.

Use default naming convention

Specifies that a connection name is generated based on the name of the subsystem that you are connecting to. This connection name is displayed after you create the connection.

Connection name

Type a name for the connection. Available only if Use default naming convention is not checked.

JDBC driver

Specify a JDBC driver to use to connect to the subsystem. JDBC drivers that appear in the list are fully supported. If a driver that you want to use is not listed but it is supported by the database manager, select Other Driver Default and provide the details.

Click ... next to the JDBC driver field to open a window so that you can modify the path to the JAR files that are being used for a particular JDBC driver. You can also use this window to view the names and typical locations for JDBC JAR files for each listed driver.

Global driver properties are set in the Preferences window, on the Driver Definitions page. To get to that page, select Window > Preferences. Then, in the Preferences window, expand Data Management > Connectivity.

The IBM Data Server Driver for JDBC and SQLJ is included with the workbench product, and by default the wizard uses the included version of the driver. It is recommended that you use this version, because it has been tested thoroughly. If you want to use a different version of this driver, you can modify the path to the required JAR files by clicking ... Other JDBC drivers for IBM data servers might also be included, depending on the workbench product that you are using.

JDBC driver limitation: Some drivers require a pass code or license file. Although license information can be set or available in the current environment, the information might not be available in other environments, such as on a Web server. The driver does not work if the pass code or license is not available.
Database
This field appears when DB2 for Linux, UNIX, and Windows is
the selected database manager because you are connecting to
the subsystem through a gateway. Specify the name of the
subsystem.

Location
This field appears when DB2 for z/OS is the selected database
manager. Type the DB2 location name that is defined during
installation. You must enter the name in upper case. To
determine the location, host, and port that should be used for
DB2 for z/OS connections, a DB2 for z/OS system programmer
or DBA can issue a <cmd prefix="" >DIS DDF where <cmd
prefix="" > is a preassigned character in your system for a
particular DB2 subsystem.

Host
If you are connecting directly to the subsystem, specify the
TCP/IP host name or TCP/IP address of the subsystem.
If you are connecting through a gateway, specify the TCP/IP
host name or TCP/IP address of the gateway.

Port number
If you are connecting directly to the subsystem, specify the
TCP/IP connection port for the selected subsystem.
If you are connecting through a gateway, specify the TCP/IP
connection port for the gateway.

Retrieve objects created by this user only
This field appears when DB2 for z/OS is the selected database
manager. Select to load objects that were created by the user
who is specified in the User ID field.

Default schema
Type the name of the schema to use for unqualified database
object references in SQL statements. If you want SQL
statements to refer to database objects that are in other
schemas, you must qualify the names of the objects with the
names of their corresponding schemas.

Connection URL
Shows the generated JDBC URL for the JDBC driver that you
are using. The URL identifies the database so that the driver
can establish a connection. The URL format depends on the
driver.

Properties - Optional
Specify additional connection properties, for example: readonly = true.
The properties that you can specify are different for every JDBC driver.
Refer to the JDBC driver documentation for more examples.

For best performance, you should use filters when you are connecting to a
large database.
If you do not specify filtering options in the wizard, you can modify them later
by modifying connection properties or by specifying data object filter options.
(For information about these options, see "Data object filters" at
http://publib.boulder.ibm.com/infocenter/dstudio/v3r1/topic/
com.ibm.datatools.server.ui.doc/topics/chilters.html). To modify connection
properties, right-click a connection and select Properties.
Filtering is not enabled by default on the wizard page. To filter your connection, clear the Disable filter check box, then specify filtering options either by using an expression or by selecting specific objects to include or not include in the connection view.

4. Complete all other wizard steps and click Finish.

Results

The connection is displayed in the Data Source Explorer or the Administration Explorer, depending on which view you started in.

Packages to bind on DB2 for z/OS subsystems for the no-charge tuning features

On each DB2 for z/OS that runs the SQL statements that you tune, you must bind certain packages to enable various functions of the IBM Data Studio client.

You can bind the packages by using the IBM Data Studio client or by running an AOCDDDL sample JCL job. After the packages are bound from a particular workstation, you do not need to bind again to connect from the IBM Data Studio client on another workstation.

Basic packages

AOC5OADM
This package accesses catalog tables to check the existence of the objects, such as tables and databases that are used for query tuning. This package also checks the format of objects, such as tables and columns.

AOC5OEPK
On a DB2 for z/OS Version 9 or Version 10 subsystem, this package accesses catalog information for any tables on which the EXPLAIN statement is issued. This package accesses information about columns, indexes, table spaces, and their statistics.

AOC5OFMJ
For the query formatting feature, this package accesses catalog tables on a DB2 for z/OS Version 8 or Version 9 subsystem. This package obtains the DDL statements for views and the materialized query tables.

AOC5OFMM
For the query formatting feature, this package accesses catalog tables on a DB2 for z/OS Version 10 subsystem. This package obtains the DDL statements for views and the materialized query tables.

AOC5ONPT
This package accesses QMF™ control tables in case the current user does not have SYSADM authority.

AOC5OPKG
This package accesses catalog tables to check the existence of the package, and retrieves the privileges that users have on the packages and tables.

AOC5OSA
For the Statistics Advisor, this package accesses statistics-profile tables that are used by the statistics advisor to manage the statistics profile.
Optional packages

AOC5OEXJ
For the SYSPROC.OPT_RUNSQL stored procedure, this package accesses workload tables and EXPLAIN tables under the DB2OSc schema on a DB2 for z/OS Version 8 new-function mode or Version 10 conversion mode from Version 8 subsystem.

AOC5OEXK
For the SYSPROC.OPT_RUNSQL stored procedure, this package accesses workload tables and EXPLAIN tables under the DB2OSc schema on a DB2 for z/OS Version 9 or Version 10 conversion mode from Version 9 subsystem.

AOC5OEXM
For the SYSPROC.OPT_RUNSQL stored procedure, this package accesses workload tables and EXPLAIN tables under the DB2OSc schema on a DB2 for z/OS Version 10 new-function mode subsystem.

Sharing EXPLAIN tables

If you want multiple people to use the same set of EXPLAIN tables when they are tuning, use one of these methods to enable sharing.

Procedure

• Create an alias that points to a set of EXPLAIN tables, grant privileges on the EXPLAIN tables to that alias, then have users connect to the subsystem by using that alias as their user name. If you use this method, the alias must point to a complete set of EXPLAIN tables. It is not possible to use an alias that is defined on a subset of EXPLAIN tables only.

• When you connect to a subsystem in the IBM Data Studio client, set the current SQLID to the schema of the EXPLAIN tables.
  1. In the Data Source Explorer, right-click the connection and click Connect.
  2. Expand the connection, right-click the subsystem, and select Analyze and Tune > Set Default SQLID and Schema.
  3. Type the qualifier of the EXPLAIN tables in the Default SQLID field in the Change Default SQLID and Schema window, and then click OK.

• Before you connect to a subsystem in the IBM Data Studio client, set the current SQLID in the global preferences.
  1. In the IBM Data Studio client, select Window > Preferences.
  2. In the Preferences window, expand Data Management > Visual Explain and select EXPLAIN Options.
  3. In the DB2 for z/OS section, select the connection.
  4. In the CURRENT SQLID field, type the schema of the EXPLAIN tables that you want to use.
  5. Click Apply, and then click OK.

• In the Invoke section of the Query Tuner workflow assistant, set the current SQLID before selecting tuning activities. For instructions to open the Invoke section for an SQL statement, see “Tuning single SQL statements with the no-charge query-tuning features in the workflow assistant” at http://publib.boulder.ibm.com/infocenter/dstudio/v3r1/topic/com.ibm.datatools.qrytune.sngqrync.doc/topics/tsupertask.html
Required EXPLAIN tables

The following EXPLAIN tables must be present on each subsystem that you use for tuning SQL statements.

The tables must be accessible to all users who need to carry out tuning activities.

Each set of tables must be in a single schema. For example, you cannot create some of a single set of EXPLAIN tables in schema A and the rest of the tables in schema B. The entire set of EXPLAIN tables must be in schema A or in schema B. Moreover, you cannot create an alias on only a subset of EXPLAIN tables. You must create the alias on the full set of tables.

EXPLAIN tables for DB2 Version 9.1 for z/OS

All of the EXPLAIN tables for DB2 Version 9.1 for z/OS must be present when you are tuning SQL statements that run on that version of DB2 for z/OS.

PLAN_TABLE

The plan table, PLAN_TABLE, contains information about access paths that is collected from the results of EXPLAIN statements.

DSN_DETCOST_TABLE

The detailed cost table, DSN_DETCOST_TABLE, contains information about detailed cost estimation of the mini-plans in a query.

DSN_FILTER_TABLE

The filter table, DSN_FILTER_TABLE, contains information about how predicates are used during query processing.

DSN_FUNCTION_TABLE

The function table, DSN_FUNCTION_TABLE, contains descriptions of functions that are used in specified SQL statements.

DSN_PGRANGE_TABLE

The page range table, DSN_PGRANGE_TABLE, contains information about qualified partitions for all page range scans in a query.

DSN_PGROUP_TABLE

The parallel group table, DSN_PGROUP_TABLE, contains information about the parallel groups in a query.

DSN_PREDICAT_TABLE

The predicate table, DSN_PREDICAT_TABLE, contains information about all of the predicates in a query.

DSN_PTASK_TABLE

The parallel tasks table, DSN_PTASK_TABLE, contains information about all of the parallel tasks in a query.

DSN_QUERYINFO_TABLE

The query information table, DSN_QUERYINFO_TABLE, contains information about the eligibility of query blocks for automatic query rewrite, information about the materialized query tables that are considered for eligible query blocks, reasons why ineligible query blocks are not eligible, and information about acceleration of query blocks.

DSN_QUERY_TABLE

The query table, DSN_QUERY_TABLE, contains information about a SQL statement, and displays the statement before and after query transformation.
DSN_SORTKEY_TABLE
The sort key table, DSN_SORTKEY_TABLE, contains information about sort keys for all of the sorts required by a query.

DSN_SORT_TABLE
The sort table, DSN_SORT_TABLE, contains information about the sort operations required by a query.

DSN_STATEMENT_CACHE_TABLE
The statement cache table, DSN_STATEMENT_CACHE_TABLE, contains information about the SQL statements in the statement cache, and information that was captured as the result of an EXPLAIN STATEMENT CACHE ALL statement.

DSN_STATEMENT_TABLE
The statement table, DSN_STATEMENT_TABLE, contains information about the estimated cost of specified SQL statements.

DSN_STRUCT_TABLE
The structure table, DSN_STRUCT_TABLE, contains information about all of the query blocks in a query.

DSN_VIEWREF_TABLE
The view reference table, DSN_VIEWREF_TABLE, contains information about all of the views and materialized query tables that are used to process a query.

EXPLAIN tables for DB2 10 for z/OS

All of the EXPLAIN tables for DB2 10 for z/OS must be present when you are tuning SQL statements that run on that version of DB2 for z/OS.

PLAN_TABLE
The plan table, PLAN_TABLE, contains information about access paths that is collected from the results of EXPLAIN statements.

DSN_COLDIST_TABLE
The column distribution table contains non-uniform column group statistics that are obtained dynamically by DB2 from non-index leaf pages.

DSN_DETCOST_TABLE
The detailed cost table, DSN_DETCOST_TABLE, contains information about detailed cost estimation of the mini-plans in a query.

DSN_FILTER_TABLE
The filter table, DSN_FILTER_TABLE, contains information about how predicates are used during query processing.

DSN_FUNCTION_TABLE
The function table, DSN_FUNCTION_TABLE, contains descriptions of functions that are used in specified SQL statements.

DSN_KEYTGTDIST_TABLE
The key-target distribution table contains non-uniform index expression statistic that are obtained dynamically by the DB2 optimizer.

DSN_PGRANGE_TABLE
The page range table, DSN_PGRANGE_TABLE, contains information about qualified partitions for all page range scans in a query.
**DSN_PGROUP_TABLE**
The parallel group table, DSN_PGROUP_TABLE, contains information about the parallel groups in a query.

**DSN_PREDICAT_TABLE**
The predicate table, DSN_PREDICAT_TABLE, contains information about all of the predicates in a query.

**DSN_PTASK_TABLE**
The parallel tasks table, DSN_PTASK_TABLE, contains information about all of the parallel tasks in a query.

**DSN_QUERY_TABLE**
The query table, DSN_QUERY_TABLE, contains information about a SQL statement, and displays the statement before and after query transformation.

**DSN_SORTKEY_TABLE**
The sort key table, DSN_SORTKEY_TABLE, contains information about sort keys for all of the sorts required by a query.

**DSN_SORT_TABLE**
The sort table, DSN_SORT_TABLE, contains information about the sort operations required by a query.

**DSN_STATEMENT_CACHE_TABLE**
The statement cache table, DSN_STATEMENT_CACHE_TABLE, contains information about the SQL statements in the statement cache, and information that was captured as the result of an EXPLAIN STATEMENT CACHE ALL statement.

**DSN_STATEMENT_TABLE**
The statement table, DSN_STATEMENT_TABLE, contains information about the estimated cost of specified SQL statements.

**DSN_STRUCT_TABLE**
The structure table, DSN_STRUCT_TABLE, contains information about all of the query blocks in a query.

**DSN_VIEWREF_TABLE**
The view reference table, DSN_VIEWREF_TABLE, contains information about all of the views and materialized query tables that are used to process a query.
Optional tasks for configuring DB2 for z/OS subsystems for tuning

Two of the tasks that are involved in configuring subsystems for tuning are optional.

Enabling the SYSPROC.OPT_RUNSQL stored procedure on a DB2 for z/OS subsystem

By enabling the SYSPROC.OPT_RUNSQL stored procedure, you can capture the SQL statements from dynamic statement caches and store these statements in the DSN_STATEMENT_CACHE_TABLE table, if you do not have the privilege to run the EXPLAIN STMTCACHE ALL statement dynamically.

Procedure

To enable the C stored procedure SYSPROC.OPT_RUNSQL:
1. Upload the tersed load module to the subsystem. You can find the load module in the \serverconfig\ZOS\OS_VERSION_NUMBER_AND_MODE\Load Module subdirectory of the installation directory.
   Ensure that the following transfer rules are specified.
   ftp> quote site blk=6144 lrecl=1024 recfm=fb tracks unit=sysallda primary=90
   200 SITE command was accepted
   ftp> binary
   200 Representation type is Image
2. Use the following sample job to unterse the load module to a partition data set.
   ```
   //**************************************************************
   //* Notes =
   //* PRIOR TO RUNNING THIS JOB,
   //* locate and change the string "!!" to the following suffix
   //* for the different versions of DB2 for z/OS:
   //* For V8 and V10CM8, change to "J".
   //* For V9 and V10CM9, change to "K".
   //* For V10NFM, change to "M".
   //**************************************************************
   //UNTERSE JOB CLASS=A,MSGLEVEL=(1,1),
   // NOTIFY=&SYSUID
   //UNTERSE EXEC PGM=TRSMAIN,PARM='UNPACK'
   //STEPLIB DD DISP=SHR,DSN=IBMUSER.TERSE.LOADLIB
   //SYSPRINT DD SYSOUT=*,DCB=(LRECL=1024,BLKSIZE=6144,RECFM=FB)
   //INFILE DD DISP=SHR,DSN=USER.TERSED.AOCRNSQ!!
   //OUTFILE DD DSN=USER.UNTERSED,
   // UNIT=3390,VOL=SER=DK8320,SPACE=(CYL,(5,5),RLSE)
   /*
   //**************************************************************
   ```
3. Copy the untersed load module to your user EXIT library.
4. Ensure that the EXIT library is concatenated to your DB2 start task STEPLIB.

Configuring database groups

To be able to capture a workload from the statement cache on all subsystems of a data sharing group, you must configure a database group in the client. This database group must contain the same members of the data sharing group in a Parallel Sysplex® in your DB2 for z/OS environment.
Before you begin

- Ensure that the data sharing group that you want to access exists in a Parallel Sysplex in your DB2 for z/OS environment.
- Ensure that you know the connection details of the subsystems in the data sharing group.

About this task

A data sharing group is a collection of one or more DB2 for z/OS subsystems that share DB2 data. A DB2 subsystem that belongs to a data sharing group is a member of that group. Each member can belong to one, and only one, data sharing group. All members of a data sharing group share the same DB2 catalog and directory, and all members must be in the same Parallel Sysplex. Data sharing improves the availability of DB2 data, extends the processing capacity of the system, provides more flexible ways to configure your environment, and increases transaction rates.

The SQL statements that are used by an application can run on multiple subsystems. If these subsystems are members of a data sharing group, you can configure a database group in the client to contain the same members. You can then define a workload to contain all SQL statements of the application from the statement cache, and capture the workload from the data sharing group.

For information about how data sharing work, see these references:

- For DB2 Version 9.1 for z/OS:
- For DB2 10 for z/OS:

Procedure

To configure a database group in the client:

1. To open the Database Groups view, click the Database Groups tab. If the tab is not visible, click Window > Show View > Database Groups.
2. Configure a database group by creating a group and adding the same members of the data sharing group. Ensure that the connection profiles of a subsystem are correct when you add the subsystem to a group.
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice as follows:
## Index

### A
- authorities and privileges
  - for binding packages 4
  - for browsing subsystem parameters 4
  - for configuring DB2 for z/OS 4
  - for creating aliases on EXPLAIN tables on DB2 for z/OS 4
  - for creating EXPLAIN tables on DB2 for z/OS 4
  - for freeing packages 4
  - for managing users on DB2 for z/OS 4

### C
- configuring DB2 for z/OS
  - by running JCL 1
  - by using the Data Studio full client 3
  - overview 1
- connecting to DB2 for z/OS subsystems
  - directly 6
  - through a gateway 6

### D
- data sharing group
  - configuring 14
- database group
  - configuring 14
- DB2 Connect 6
- DBRMs
  - descriptions 8
  - list of 1
- dropping databases before configuring DB2 for z/OS 1, 3

### E
- EXPLAIN tables
  - descriptions 10
  - sharing 9

### I
- IBM Optimization Service Center 1, 3

### J
- JCL jobs 1

### P
- package descriptions 8

© Copyright IBM Corp. 2012